<table>
<thead>
<tr>
<th>New Internet features</th>
<th>2-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIF and JPEG support</td>
<td>2-2</td>
</tr>
<tr>
<td>Export to an HTML table</td>
<td>2-2</td>
</tr>
<tr>
<td>Send Mail script step</td>
<td>2-2</td>
</tr>
<tr>
<td>URL support</td>
<td>2-2</td>
</tr>
<tr>
<td>Open URL script step</td>
<td>2-2</td>
</tr>
<tr>
<td>Expanded Sort and Find options</td>
<td>2-3</td>
</tr>
<tr>
<td>New calculation functions</td>
<td>2-3</td>
</tr>
<tr>
<td>Layout and interface enhancements</td>
<td>2-3</td>
</tr>
<tr>
<td>Excel import</td>
<td>2-3</td>
</tr>
<tr>
<td>IntelliMouse support for Windows 95 and Windows NT</td>
<td>2-3</td>
</tr>
</tbody>
</table>

**Appendix A: Installing Win32s**

<table>
<thead>
<tr>
<th>Removing earlier versions of Win32s</th>
<th>A-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Win32s 1.30c</td>
<td>A-2</td>
</tr>
</tbody>
</table>
Chapter 1: Installing FileMaker Pro

Welcome to the FileMaker Pro application from Claris Corporation. FileMaker Pro is designed to help you manage information easily and effectively.

About this guide

This FileMaker Pro Installation and New Features Guide includes instructions for installing the application on your hard disk.

- Chapter 1, “Installing FileMaker Pro,” gives instructions for installing the application, registering your ownership, and everything else you need to do before you can use FileMaker Pro.
- Chapter 2, “New features in FileMaker Pro,” provides an overview of the new features in FileMaker Pro 4.0. This chapter is especially helpful for users upgrading from previous versions of FileMaker Pro.
- Appendix A, “Installing Win32s,” provides information on installing and removing Win32s.

This installation guide, the FileMaker Pro User’s Guide, and the onscreen Help system work together to give you the information you need to know as you learn about FileMaker Pro.

Registration and customer support

Please take the time to complete and mail the product registration card that is included in this package. Refer to our Web site at http://www.claris.com for information about customer support.

U.S. and Canadian retail customers can also refer to the Claris Service Directory included with the software. For customers outside of the U.S. or Canada, refer to the Technical Support brochure included with the software.
What you need to install FileMaker Pro

This guide gives instructions for installing the FileMaker Pro application and associated files on your PC. Before you begin installing, you must know how you plan to use FileMaker Pro.

- On a stand-alone computer—you want to use FileMaker Pro on your computer, and you don’t plan to share files with other users over a network.
- With networking—you want to use FileMaker Pro on your computer, and you plan to share FileMaker Pro files with other computers using either TCP/IP or IPX/SPX networking software.

If you’re on a network You need to know which type of network you’re using. If you’re not sure which network option to choose, check with your network administrator before you begin installation.

Minimum hardware and software requirements

To install and use FileMaker Pro, you need the CD-ROM disc in the FileMaker Pro package and the following minimum equipment and software:

- an Intel compatible 486/33 PC or higher with 8 MB of RAM
- a hard disk
- a CD-ROM drive
- Windows 95, Windows NT 3.51 or later, Windows for Workgroups 3.11, or Windows 3.1

You also need your FileMaker Pro Installation Code to install and run the application. Look for it in the product package.

Networking requirements

To share files among users on a network, you need to have the following additional software and hardware installed on your PC:

- a Windows-compatible network card
- the software driver for your network card
- the appropriate TCP/IP network protocol or IPX/SPX network protocol for Windows 95, Windows NT, Windows for Workgroups, or Windows 3.1
You can use one of the following solutions to share files on a PC or cross-platform network. See the documentation that came with Windows or your network card for more information.

### Web publishing requirements

To publish a database on the Web using the FileMaker Pro Web Companion, you need a host computer with access to the Internet or an intranet via TCP/IP. The host computer must be either a PC running Windows 95 or Windows NT 3.51 or later, or a Mac OS computer.

**Note** Web publishing in FileMaker Pro 4.0 is not supported under Windows 3.1 or Windows for Workgroups.

**Important** Access to the Internet requires an Internet service provider. FileMaker Pro does not provide an Internet account for you.

### Requirements for advanced features

Some of the advanced features of FileMaker Pro 4.0 require additional software.

<table>
<thead>
<tr>
<th>FileMaker Pro 4.0 advanced feature</th>
<th>Software requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL support</td>
<td>URL.DLL</td>
</tr>
<tr>
<td>Open URL script step</td>
<td>URL.DLL</td>
</tr>
<tr>
<td>Send Mail script step</td>
<td>MAPI (Mail API) enabled email client software</td>
</tr>
<tr>
<td>Phone dialing</td>
<td>Phone dialer or other TAPI (Telephony API) compliant software</td>
</tr>
<tr>
<td>Instant Web Publishing</td>
<td>URL.DLL</td>
</tr>
<tr>
<td>Custom Web Publishing</td>
<td>HTML editing software, such as Claris Home Page 3.0 software. Web browser software is suggested to view your work.</td>
</tr>
<tr>
<td>IntelliMouse support</td>
<td>IntelliPoint software (included with the IntelliMouse)</td>
</tr>
</tbody>
</table>

The DLL and the API files are normally installed with a Typical installation of Windows 95 and Windows NT 3.51 and 4.0.
Before you begin

Before you begin the installation process, exit all other open programs and save your work. Use Alt + Tab to switch between programs.

Installing with Windows 95 or Windows NT 4.0

You must use the installation program to install FileMaker Pro—you can’t install FileMaker Pro by dragging files to your hard disk.

To install FileMaker Pro on your hard disk:
1. Insert the CD-ROM disc into your CD-ROM drive.
   You see the FileMaker Pro screen.

2. For late-breaking information about FileMaker Pro, view the Read Me file. You can also browse the contents of the CD, if you wish.
3. Click the Install FileMaker Pro 4.0 button.
   You see the software license agreement.
4. Click Accept to accept the license agreement.
   You see the Welcome screen.
5. Click Next.
You see the FileMaker Pro Installation dialog box.

Follow the steps described in one of the following sections:

- If you want to install all the available files, continue with Typical installation.

- If you want to install a subset of the FileMaker Pro files, skip to “Compact installation or Custom installation” on page 1-8.

With a Compact installation, the following files are not installed:

- Networking files
- Web Companion and Web publishing files
- Tutorial and example files
- Translator and import files
- Dictionary files

With a Custom installation, you can install just the files you want.
**Typical installation**

Follow these steps to install the complete FileMaker Pro package on your Windows 95 or Windows NT 4.0 system.

To install all the FileMaker Pro files on your hard disk:

1. If you have not already done so, insert the CD-ROM disc.
   Follow the instructions on page 1-4.

2. In the FileMaker Pro Installation dialog box, choose **Typical**. If you want to install FileMaker Pro in another folder or on another drive, click the **Browse** button. If the selected disk doesn’t have enough space for the files you select, you can leave the installer and delete existing files to make more room on the disk. If the disk is locked, or isn’t a hard disk, you can choose another drive.

3. Click **Next**.
   You see the Network Protocol dialog box.

   ![Network Protocol dialog box]

   If you want to network your files, select a protocol. You can change the network protocol later, without re-installing the program. For help in deciding which network protocol to select, see your network administrator.

4. Click **Next**.
   The installer tells you if the selected drive doesn’t have enough space for the network files you select.
Otherwise, you see the Personalization dialog box.

5. In the Name box, type your name and press the Tab key.

6. Type your company name, if applicable, and press Tab.
   If you don’t have a company name, you can put other information (like your address) in the box or leave it blank.

   The Installation Code number is not optional. Look for your Installation Code in the product package.

8. Click Next.
   If you’ve made an error typing your name or company, follow the instructions provided on the screen.

9. Click Next.
   The Installer begins copying files. A dialog box tells you what the Installer is doing.
   After all the files are installed, a final dialog box tells you the installation on your hard disk was successful.
After the installation program copies all the files, it creates a menu item for FileMaker Pro in the Start menu.

Compact installation or Custom installation

To install a subset of FileMaker Pro files on your hard disk:

1. If you have not already done so, insert the CD-ROM disc.
   Follow the instructions on page 1-4.

2. In the FileMaker Pro Installation dialog box, choose Compact or Custom.
If you want to install FileMaker Pro in another folder or on another drive, click the **Browse** button. If the selected disk doesn’t have enough space for the files you select, is locked, you can leave the installer and delete existing files to make more room on the disk. If the disk is locked, or isn’t a hard disk, you can choose another drive.

3. Click **Next**.

If you’ve selected **Custom**, the dialog box lists the files you can install.

4. For a Custom installation, click next to a filename to select files you want to install.

Any file with a checkmark will be installed.

5. Click **Next**.
If you are installing the FileMaker Pro application, you see the Personalization dialog box.

6. In the **Name** box, type your name and press the Tab key.
7. Type your company name, if applicable, and press Tab.
   If you don’t have a company name, you can put other information (like your address) in the box or leave it blank.
8. In the **Installation Code** box, type your FileMaker Pro Installation Code.
   The Installation Code number is not optional. Look for your Installation Code in the product package.
9. Click **Next**.
   If you’ve made an error typing your name or company, follow the instructions provided on the screen.
10. Click **Next**.
    The Installer begins copying files. A dialog box tells you what the Installer is doing.
    After the selected files are installed, a final dialog box tells you the installation on your hard drive was successful.

If you’ve installed the FileMaker Pro application, the installation program creates a menu item for FileMaker Pro in the **Start** menu.
Uninstalling FileMaker Pro for Windows 95 or Windows NT 4.0

1. Open the Add/Remove Programs control panel.
2. Click the Install/Uninstall tab and select FileMaker Pro 4.0 from the list.
3. Click Add/Remove.

Earlier versions of FileMaker Pro can be removed the same way.

Note: Uninstalling doesn’t delete files that you’ve created, as long as they are named differently than the files that are installed with FileMaker Pro.

Installing with Windows 3.1, Windows for Workgroups, or Windows NT 3.51

If you are using Windows 3.1 or Windows for Workgroups 3.11, you need to install Win32s 1.30c before installing FileMaker Pro. If an earlier version of Win32s is installed on your system, the older version must be removed and Win32s 1.30c must be installed. See appendix A, “Installing Win32s” for further information.

Typical installation

To install FileMaker Pro with Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51:

1. Start Windows.
2. Insert the CD-ROM disc into the CD-ROM drive.
3. Choose Run from the Program Manager’s File menu.
4. Type the drive letter for the CD-ROM drive and the path for the setup command in the Command Line box (for example, d:\setup) and click OK.
5. Follow the installation instructions provided on the screen.

Compact installation or Custom installation

For information on installing a subset of the FileMaker Pro files, see “Compact installation or Custom installation” on page 1-8.
Uninstalling FileMaker Pro for Windows 3.1, Windows for Workgroups, or Windows NT 3.51

1. Open the FileMaker Pro program group.
2. Double-click **Uninstall FileMaker Pro**.

**Note** Uninstalling doesn’t delete files that you’ve created, as long as they are named differently than the files that are installed with FileMaker Pro.

Updating your User Dictionary

If you have added words to your User Dictionary in either a previous version of FileMaker Pro or another Claris product, then you must export that User Dictionary to a text file, then import it into FileMaker Pro 4.0.

1. Export your User Dictionary using your other Claris product.
2. In FileMaker Pro 4.0, choose **Spelling** from the Edit menu, then choose **Edit User Dictionary**.
3. Click **Text File** to show the **Import** and **Export** buttons.
4. Click **Import** and import the text file containing the words from your previous User Dictionary.

Where files are stored on your hard disk

The following tables show the files and folders you can install, and the preferred location for them on your hard disk. With a Typical installation, the FileMaker Pro Installer installs all the files you need in their preferred locations.

**Location of the FileMaker Pro 4.0 folder** In Windows 95 and Windows NT 4.0, the FileMaker Pro folder is installed by default in the Claris Corp folder in the Program Files folder. In Windows 3.1, Windows for Workgroups, or Windows NT 3.51, the FileMaker Pro directory is installed by default in the root directory.
### FileMaker Pro 4.0 folder

This table shows the files and folders in the FileMaker Pro 4.0 folder.

<table>
<thead>
<tr>
<th>Folder location in Windows 95 and Windows NT 4.0</th>
<th>Folder location in Windows 3.1, Windows for Workgroups, and Windows NT 3.51</th>
<th>File or folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Pro 4.0 folder</td>
<td>fmpro40</td>
<td>FILEMAKER PRO.EXE (FMPRO.EXE in Windows 3.1, and Windows for Workgroups)</td>
<td>Application file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>README.WRI</td>
<td>Text document about FileMaker Pro</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CLINGENU.DLL</td>
<td>Claris Spelling engine module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMENGINE.DLL</td>
<td>FileMaker application module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMOLE.DLL</td>
<td>FileMaker application module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMRSRC.DLL</td>
<td>FileMaker application module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMATM16.DLL</td>
<td>Support for Adobe Type Manager (Windows 95 and Windows NT 4.0 only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMATM32.DLL</td>
<td>Support for Adobe Type Manager (Windows 95 and Windows NT 4.0 only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMTOOLS.DLL</td>
<td>FileMaker application module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMPRO40.HLP</td>
<td>FileMaker Pro online help documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMPRO40.CNT</td>
<td>FileMaker Pro online help documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMPRO40.FTS</td>
<td>A file generated by the Help system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FMPRO40.GID</td>
<td>A file generated by the Help system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CLPROOF.DLL</td>
<td>Spelling engine</td>
</tr>
<tr>
<td>Template folder</td>
<td>template</td>
<td>TEMPLATE</td>
<td>Folder containing predesigned templates that help you use FileMaker Pro right away</td>
</tr>
<tr>
<td>Examples folder</td>
<td>examples</td>
<td>EXAMPLES</td>
<td>Folder containing database examples that use the relational capabilities of FileMaker Pro 4.0</td>
</tr>
<tr>
<td>Tutorial folder</td>
<td>tutorial</td>
<td>TUTORIAL.FP3</td>
<td>A FileMaker Pro tutorial database</td>
</tr>
<tr>
<td>Web folder (for Web publishing, do not move or rename this folder)</td>
<td>web (Windows NT 3.51 only)</td>
<td>Employee Database files Guest Book files Shopping Cart files</td>
<td>Example databases and HTML files that you can use to learn about Custom Web Publishing</td>
</tr>
<tr>
<td>Folder location in Windows 95 and Windows NT 4.0</td>
<td>File or folder</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Web Tools folder \web tools (Windows NT 3.51 only)</td>
<td>CDML Reference</td>
<td>For Custom Web Publishing, a FileMaker database that documents how to use the Claris Dynamic Markup Language (CDML) to create HTML format files for Custom Web Publishing; contains a Developer's Guide</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CDML Tool</td>
<td>For Custom Web Publishing, a FileMaker database that helps you create HTML files that contain CDML tags, using Copy and Paste</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CDML Template folder</td>
<td>For Custom Web Publishing, HTML files containing CDML tags for the standard actions (Add Record, Search, and so on), to be used as building blocks for your Custom Web Publishing files</td>
<td></td>
</tr>
<tr>
<td>Web Security folder \web security (Windows NT 3.51 only)</td>
<td>Databases folder Security folder</td>
<td>A folder containing the FileMaker databases and HTML files required to use Web Security Database safeguards</td>
<td></td>
</tr>
<tr>
<td>Claris folder windows\claris</td>
<td>USENGLISH.MPR</td>
<td>The primary dictionaries that FileMaker Pro uses to spell check your files. You can select either U.S. or British spellings for your main dictionary. Each dictionary contains over 100,000 words.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UKENGLISH.MPR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>USER.UPR</td>
<td>The dictionary that stores your customized list of spelling exceptions and additions to the primary dictionaries</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CLADDON CLR</td>
<td>An additional dictionary that contains computer terminology</td>
<td></td>
</tr>
<tr>
<td>File or folder</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DELSL1.ISU</td>
<td>A log file, used by the uninstaller</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMIPX32.NET</td>
<td>IPX/SPX network plug-in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMTCP32.NET</td>
<td>TCP/IP network plug-in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CWORKKS.IMP</td>
<td>ClarisWorks database translation filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBF.IMP</td>
<td>DBF database translation filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXCEL.IMP</td>
<td>Microsoft Excel translation filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMBMP32.FLT</td>
<td>BMP graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMCGM32.FLT</td>
<td>CGM graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMDRW32.FLT</td>
<td>DRW graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMGIF32.FLT</td>
<td>GIF graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMHPGL2.FLT</td>
<td>HPGL graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMMAC32.FLT</td>
<td>MacPaint graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMPCX32.FLT</td>
<td>PCX graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMPIC32.FLT</td>
<td>PIC graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FSMLD32.FLT</td>
<td>Lotus SLD graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMTIFF32.FLT</td>
<td>TIFF graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMWMF32.FLT</td>
<td>Metafile graphic filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTL3D32.DLL</td>
<td>Windows 3-D interface (Windows 3.1, Windows for Workgroups, and Windows NT 3.51 only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOCICON.ICO</td>
<td>Contains icons for the application</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FMHOSTS.TXT</td>
<td>Stores your lists of hosts which appear in the TCP/IP network dialog box</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WEBCOMPN.FMX</td>
<td>The Web Companion plug-in that enables Web publishing from FileMaker Pro (Windows 95, Windows NT 3.51, and Windows NT 4.0 only)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Windows System Directory folder

The following table shows the files and folders installed in the Windows System Directory folder.

<table>
<thead>
<tr>
<th>Folder location in Windows 95 and Windows NT 4.0</th>
<th>Folder location in Windows 3.1, Windows for Workgroups, and Windows NT 3.51</th>
<th>File or folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows System Directory</td>
<td>\windows\system</td>
<td>NWIPXSPX.DLL</td>
<td>Networking file</td>
</tr>
<tr>
<td>(Windows 3.1 and Windows for Workgroups),</td>
<td></td>
<td>NWINETAPL.DLL</td>
<td>Networking file</td>
</tr>
<tr>
<td>\winnt35\system32\</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Windows NT 3.51)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adjusting the FileMaker Pro cache

FileMaker Pro maintains an internal cache of portions of your database. Depending on your computer’s memory configuration, you may want to adjust the cache size to improve performance.

You may want to consider increasing the cache size if you plan to:

- work on a large database file
- work on several database files at once
- host database files
- use a database file that contains many graphics
- insert a large graphic into a database file

Consider decreasing the cache size if you plan to run several applications at the same time and you have a limited amount of memory (RAM) installed.

**Note** By changing the FileMaker Pro cache size, you also affect the amount of memory needed to run FileMaker Pro.

For more information on managing memory, see the documentation that came with your computer.
Changing the cache size

To change the cache size that FileMaker Pro uses:

1. In FileMaker Pro, choose **Preferences** from the Edit menu and then choose **Application**.

   You see the Application Preferences dialog box.

2. Click the **Memory** tab at the top of the dialog box.

![Application Preferences dialog box]

3. Type a number in the **Attempt cache size of** box.

4. Click **Done**.

The next time you start FileMaker Pro, the new cache size is used.

**Adjusting network software**

Depending on the networking protocol you’re using, you may have to modify settings on the host and/or guest computers.

**If you are using the IPX/SPX protocol with Windows 95 or Windows NT** To allow the maximum number of guests (25), your IPX/SPX connections must be set to 60 or greater. Consider increasing the SPX connections to 60 in the Network control panel if you cannot connect the desired number of guests. You do not need to modify settings on Windows NT.
If you are using the IPX/SPX network with Windows 3.1 or Windows for Workgroups 3.11, you should use the Novell NetWare Client Shell version 3.26 or later to share FileMaker Pro files. You’ll need to change Novell NetWare settings in order to network FileMaker Pro. To share FileMaker Pro files over the network, your machine must be a fully configured NetWare client.

To share FileMaker Pro database files:

- Use the Windows Setup program to set the network to the appropriate NetWare option (usually NetWare 3.26 or later).
- Add the following entries to your NET.CFG (or SHELL.CFG) file:
  ```
  GET LOCAL TARGET STACKS=10
  SPX CONNECTIONS=40
  ```

Get local target stacks needs to be set on all guest machines. SPX connections should be set on the host machine if it will host more than twelve guests, or on guest machines using additional SPX applications. Consider increasing the SPX connections if you cannot connect the desired number of guests.

Changing the network protocol

During installation, you select a network protocol (or No Networking) for FileMaker Pro. You can change the network protocol at any time.

You must choose a network protocol if you want to share FileMaker Pro files over a network, either as a guest or as a host. For more information about your network configuration, consult your network administrator.

Important The network protocol setting in FileMaker Pro must be the same on the host and guest computers.

To change the network protocol:

1. Start FileMaker Pro 4.0.
2. Choose Preferences from the Edit menu, and then choose Application.

You see the Application Preferences dialog box. If necessary, click the General tab to bring the General preferences to the front.
3. Choose a network protocol from the Network Protocol drop-down list.

![Network Protocol drop-down list]

**Note** In Windows 3.1, FMIPX32.NET and FMTCP32.NET appear in the drop-down list.

Changes to this setting don’t take effect until you exit FileMaker Pro and then start it again.

**Changing the frame type**

A frame encapsulates packets of information in a recognizable format. Each packet on the network must conform to a specific frame type to successfully communicate with other computers on the network. After you select the network protocol, you must select a frame type.

**Note** All computers communicating with each other on the network must use the same frame type. For help in deciding which frame type to select, see your network administrator.
Changing the frame type in Windows 95
If you are using TCP/IP networking, you do not need to change the frame type. To change the frame type with IPX/SPX networking:
1. Open the Network control panel and click the **Configuration** tab.
2. Open **IPX/SPX Compatible Protocol** and click **Properties**.
3. Click the **Advanced** tab.
4. Click the frame type in the Property dialog box.
5. Make a selection from the Value drop-down list.
6. Click **OK**.

Windows 95 prompts you to restart your computer for these new changes to take effect.

Changing the frame type in Windows NT
If you are using TCP/IP networking, you do not need to change the frame type. To change the frame type with IPX/SPX networking:
1. Right-click **Network Neighborhood**.
2. Select **Properties** from the menu.
   - You see the Network dialog box.
3. Click the **Protocols** tab.
4. Click **NWLink IPX/SPX**.
5. Click **Properties**.
6. Select a frame type from the drop-down list.
7. Click **OK** to apply the frame type.
8. Click **OK** to close the Network dialog box.

Windows NT prompts you to restart your computer for these new changes to take effect.

Changing the frame type in Windows 3.1 and Windows for Workgroups
For information on changing the frame type in Windows 3.1 and Windows for Workgroups, please refer to the documentation that came with your networking software.
Opening files from previous versions

FileMaker Pro 4.0 can open both Windows and Mac OS-compatible files created by FileMaker Pro 2.0 or later.

Important You do not need to convert 3.x files. In FileMaker Pro 4.0, you can open files created with FileMaker Pro 3.x; in FileMaker 3.x, you can open files created with FileMaker Pro 4.0. However, new 4.0 features aren’t supported when you open files in 3.x. For example, rotated fields will appear as horizontal (left to right) fields in 3.x.

FileMaker Pro 1.0 databases To use a database created by FileMaker Pro 1.0, you must first convert it on a Mac OS computer with version 2.0 or later and then open it in FileMaker Pro for Windows.

To use files created with FileMaker Pro 2.x, you must convert them to FileMaker Pro 4.0.

To convert and open a FileMaker Pro 2.x file:

1. Start FileMaker Pro 4.0.
2. Choose Open from the File menu and select the file you want to convert in the Open dialog box.
   You see the Conversion dialog box.
3. Type a name to rename the original file, or deselect the Rename old file checkbox to retain the name of the file.

If you use the default settings, original file remains in the older format. After you click OK, you see another dialog box where you can name the file that will be created and saved in the new format. You cannot use the converted file with versions of FileMaker Pro earlier than 3.0.

4. Click Save to start the conversion.
   FileMaker Pro converts the file and opens it.
Where to go from here

After you install FileMaker Pro, you can immediately begin working with the application. Here are some suggestions on where to go in the documentation to get started:

- If you’re new to databases, read chapter 1, “FileMaker Pro basics,” in the *FileMaker Pro User’s Guide* to learn basic database concepts.
- If you’re new to FileMaker Pro, work through the online tutorial, which is automatically copied to your hard disk when you do a Typical installation.
- If you’ve used FileMaker Pro before, read chapter 2 of this guide to find out about the new features available in FileMaker Pro 4.0.
Chapter 2: New features in FileMaker Pro

This chapter introduces the new features available in FileMaker Pro 4.0.

Web publishing capabilities

Using FileMaker Pro 4.0, you can access your database from almost anywhere in the world. Your file can be viewed, edited, sorted, and searched with just Web browser software and access to the Internet or your intranet. You can also choose how much or how little access users have to your file.

Note Access to the Internet requires an Internet service provider. FileMaker Pro does not provide an Internet account for you.

Instant Web Publishing

With FileMaker Pro 4.0, you can quickly publish your database on the Internet or on an intranet, using the FileMaker Pro Web Companion.

This functionality is built in—no additional CGI or Web server software is required for either Windows 95, Windows NT, or the Mac OS. However, access to the Internet requires an Internet account.
Custom Web Publishing

You can create a complete, custom, interactive Web solution using FileMaker Pro 4.0 Web Companion and dynamic HTML files. FileMaker Pro now can publish HTML documents containing GIF and JPEG graphics, animated GIF files, QuickTime movies, AIFF files, or Java applets.


New Internet features

Note Some of these features require additional software. See “Requirements for advanced features” on page 1-3.

GIF and JPEG support

FileMaker Pro 4.0 supports GIF and JPEG graphic formats in layouts, container fields, and published Web pages. When FileMaker Pro sends an image to a Web browser, it can send either a GIF or JPEG image. If one is not available, the stored graphic is converted on-the-fly to JPEG for display, even if it is not stored in JPEG format in the database.

Export to an HTML table

You can now export all or part of your database formatted as an HTML table.

Send Mail script step

With email client software, you can send email via the Internet or your intranet directly from your FileMaker Pro database.

URL support

When you right-click a URL in a field and choose Open <URL> from the context menu that appears, FileMaker Pro opens that URL. If the address is for a Web page, FileMaker Pro opens your Web browser software.

Open URL script step

You can write a script that opens a URL.
Expanded Sort and Find options

Related records can now be sorted within a portal or as part of a related list.

With the addition of exact field matches, Find requests can be even more specific.

New calculation functions

New functions help you determine:
- the current group that a password belongs to
- the modifier key being pressed by the user
- the network protocol that is loaded and in use
- the ID of the current record
- the number and kinds of objects in a layout

Layout and interface enhancements

Fields and objects can be now rotated in 90-degree increments, allowing greater flexibility in your layouts. Text can also be dragged and dropped into a rotated text block. You can zoom in or out on a rotated object.

To make creating and managing your files easier, value lists can now be defined from the File menu.

Excel import

FileMaker Pro now supports direct import of worksheets (.XLS files) from Microsoft Excel, including version 4.0 and 5.0 for Mac OS, and versions 4.0 through Excel 97 for Windows. Additionally, you can import a specific worksheet from an Excel workbook.

IntelliMouse support for Windows 95 and Windows NT

If you have an IntelliMouse, then you can use it to scroll or zoom with FileMaker Pro 4.0.

Note  FileMaker Pro 4.0 supports IntelliMouse scrolling through layouts or lists of records, not scrolling in fields or portals. Autoscroll, panning, and DataZoom are also not supported.
Appendix A: Installing Win32s

If you are using Windows 3.1 or Windows for Workgroups 3.11, you need to install Win32s 1.30c before installing FileMaker Pro. After installing Win32s, you will still be able to run all the applications you currently use. If an earlier version of Win32s is installed on your system, you must first remove the older version.

To determine the version of Win32 that’s installed on your computer:

1. In the File Manager, click WIN32S16.DLL, located in the \WINDOWS\SYSTEM directory.
   The file is highlighted.
2. Select Properties from the File menu of the File Manager.
   You see the version.

Removing earlier versions of Win32s

To completely remove an earlier version of Win32s:

1. Modify the following line from the [BOOT] section in the SYSTEM.INI:
   Change DRIVERS=MMSYSTEM.DLL WINMM16.DLL to the following: DRIVERS=MMSYSTEM.DLL
2. Remove the following line from the 386 Enhanced [386Enh] section of the SYSTEM.INI file:
   DEVICE=<WINDOWS><SYSTEM>\WIN32S\W32S.386
   where <WINDOWS> and <SYSTEM> are the locations of your WINDOWS and SYSTEM directories. In a normal Windows configuration the line will read DEVICE=C:\WINDOWS\SYSTEM\WIN32S\W32S.386
3. Exit and restart Windows.
4. Delete the following files from the <WINDOWS><SYSTEM> subdirectory or from the SYSTEM directory in network installations:
   W32SYS.DLL
   WIN32S16.DLL
   WIN32S.INI
   WINMM16.DLL
5. Delete all the files in the <WINDOWS>\<SYSTEM>\WIN32S subdirectory or the <SYSTEM>\WIN32S subdirectory in network installations. Then delete the WIN32S directory itself.

The above changes take effect the next time you run Windows.

**Note** <WINDOWS> refers to the Windows installation directory. On a networked Windows installation, the system directory may be located on a shared remote volume. If you are removing only WIN32s from your machine, then you do not need to remove the shared files in <SYSTEM> and <SYSTEM>\WIN32S. Before removing these files from the shared network, make sure that all users that use Win32s have removed the references to Win32s from the SYSTEM.INI file.

### Installing Win32s 1.30c

To install or update Win32s:

1. In the Program Manager, click the Main group.
2. Open the 386 Enhanced control panel and change the virtual memory type to Permanent.
3. Make sure the swap file size is at least 20480 KB.
4. Select Use 32-Bit Disk Access and Use 32-Bit File Access, if available.
5. Click OK
   If you made changes, you need to restart Windows before installing Win32s.

6. In the File Manager, open the Disk 1 directory that’s in the Win32s directory on the FileMaker Pro CD-ROM disc.

7. Double-click the SETUP.EXE program and follow the Win32s setup instructions.

8. When the Win32s installation is complete, the FreeCell Setup dialog box appears.

9. Claris recommends that you install and run the game FreeCell, because it can help verify your Win32s software installation.

10. Restart the machine, then install FileMaker Pro.